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СПИСОК ОБОЗНАЧЕНИЙ, СОКРАЩЕНИЙ И СИМВОЛОВ 

D, d –  диаметр, м; 

F – площадь, м
2
; 

G –  массовый расход, кг/с; 

P –  давление, Па; 

P –  площадь, м
2
; 

T – температура, К; 

V –  объем, м
3
; 

W –  скорость, м/с; 

X, Y –  текущие координаты, м; 

 –  плотность, 3м
кг ; 

t –  время, c; 

ДВС –  двигатель внутреннего сгорания; 

ТВС –  топливно-воздушная смесь; 

КВ –  коленчатый вал; 

РВ – распределительный вал; 

3D – трехмерная задача; 

CAE (Computer-aided engineering) – компьютерный инженерный анализ; 

CAD (Computer-aided design) – система автоматизированного 

проектирования;   

CFD (Computational fluid dynamics) – вычислительная гидродинамика; 

k-ε – двухпараметрическая модель турбулентности. 
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ВВЕДЕНИЕ 

Целью данного методического пособия является наглядное представление 

принципа работы авиамодельного двухтактного ДВС посредством его 

трехмерной модели. Моделирование протекания тепловых процессов внутри 

ДВС осуществляется с помощью программы ANSYS Fluent. КПД ДВС 

зависит от совокупности сложных процессов, а именно: подачи топливных 

компонентов, подготовки топливовоздушной смеси, горения топлива и 

процесса выпуска продуктов сгорания и т.д. Исследования, провидимые с 

помощью CFD-моделирования на первых этапах проектирования двигателя, 

помогают оптимизировать каждый из этих процессов. Сложности процесса 

моделирования связаны с построением модели расчетной сетки, которая 

должна двигаться в полном соответствии с тем движением, которое 

совершается рабочим телом внутри цилиндра поршневого двигателя. 

В данную методику расчета входят следующие этапы: 

 Первоначальная настройка модели внутреннего пространства ДВС для 

наглядного построения процессов, происходящих в двигателе. 

 Настройка дискретной фазовой модели Discrete Phase Model (DPM) для 

моделирования процессов подачи топлива. 

 Настройка решателя ANSYS Fluent. 

 Анализ полученных данных. 

Данный информационный ресурс может использоваться студентами и 

преподавателей для получения полей распределения основных 

термодинамических параметров в цилиндропоршневой группе  ДВС с 

помощью программы ANSYS Fluent, а также позволяет получить навыки 

работы с движущимися расчетными сетками. 
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1 МЕТОДИКА РАСЧЕТА ГАЗОДИНАМИЧЕСКИХ И ТЕПЛОВЫХ 

ПРОЦЕССОВ В ЦИЛИНДРОПОРШНЕВОЙ ГРУППЕ ДВС С 

ИСПОЛЬЗОВАНИЕМ ПРОГРАММЫ ANSYS FLUENT 

 

Вначале необходимо скопировать файл сетки miniDVS.msh и файл 

параметров профиля DVS.c в специальную рабочую папку. Данные файлы 

создаются соответственно в предпроцессоре ANSYS Workbench Meshing и 

WordPad. Затем следует запустить программу ANSYS Fluent с параметрами 

как на рисунке 1.1. 

 

Рисунок 1.1 – Меню запуска ANSYS Fluent 
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1.1 Настройка параметров сетки 

а) Откройте файл  miniDVS.msh:  

File → Read → Mesh... (рисунок 1.2). 

 

Рисунок 1.2 – Меню загрузки файла сетки 

 

Программа ANSYS Fluent cчитает файл и отображает ход чтения в окне 

командной строки. 

б) Процесс проверки сетки производится следующими командами:  

Mesh → Check 

Процедура проверки выявляет целостность конечных объемов в сеточной 

модели. Убедитесь в том, что наименьший объем отображается со знаком 

«+». 

в) Размеры расчетных моделей в программе ANSYS Fluent должны быть 

обязательно заданы в метрах. Построение моделей обычно проводится в 

миллиметрах. Так, как рассматриваемая модель цилиндра была создана в 

миллиметрах, то поэтому построенную сетку нужно уменьшить в 1000 раз. 

Для этого в программе есть удобная команда масштабирования Scale Mesh 
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(рисунок 1.3).  Проверка масштабирования сетки осуществляется с помощью 

следующих манипуляций: 

Mesh → Scale... 

 

 

Рисунок 1.3 – Меню масштаба сетки (Scale Mesh) 

 

Проверьте поле Domain Extents, чтобы убедиться в правильности выбора 

единиц измерения. Главное, чтобы масштаб сетки соответствовал 

проведенным построениям. 

г) Просмотр конечно-элементной сетки. 

Для того чтобы просмотреть конечно-элементную сетку загруженной 

модели (рисунок 1.4) необходимо с помощью команды совершить 

следующие действия: 

Display → Mesh... 
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Рисунок 1.4 – Меню отображения сетки (Display – Mesh) 

 

д) На следующем этапе необходимо для удобства работы установить 

разные цвета сетки для ее разных областей. Для этого следует использовать 

команду Colors. При этом открывается окно  Mesh Colors (цвет сетки), 

которое показано на рисунке 1.5. 

 

Рисунок 1.5 – Меню выбора цвета сетки (Mesh Colors). 

 

В этом меню выполняют последовательно следующие операции: 

 Необходимо выбрать  Color by ID в списке опций Options. 
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 Затем следует закрыть окно Mesh Colors. 

е) Затем необходимо использовать  команду Display в окне Mesh Display и 

закрыть данное  окно. На рисунке 1.6 можно увидеть, что сеточная модель 

разделена на несколько областей с различной сеткой. Некоторые области 

состоят из элементов блочной структуры, другие – из элементов, имеющих 

форму призм. 

 

Рисунок 1.6 – Внешний вид расчетной модели 

 

1.2. Настройка модели решателя 

Для решения данной задачи выбирается нестационарный метод 

моделирования с учетом  турбулентных течений (рисунок 1.7). 

1. Выбирается тип задачи – нестационарный:  

Define → General → Solver... 
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Рисунок 1.7 – Меню опций решателя (Solver) 

 

а) В окне настроек General выбирается режим Transient. 

б) Для решения данной задачи рекомендуется использовать настройку 

Pressure Based (в российской литературе его называют алгоритмом 

установления), которая является на сегодняшний день хорошо отработанной 

и эффективной для широкого ряда задач, в том числе и для задач  подобного 

рода. 

2. Для обеспечения высокой точности расчетов необходимо выбрать 

соответствующую для данной задачи модель турбулентности. Учитывая 

сложность задачи,  рекомендуется использовать k-ε модель турбулентности 

(рисунок 1.8).  Для этого настройка модели турбулентности вызывается 

следующим образом: 

Define → Models →Viscous...  
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Рисунок 1.8 – Меню выбора модели турбулентности(Viscous Model) 

 

В ней выполняются следующие действия: 

 Выбирается модель турбулентности k-epsilon(2 eqn) в списке Model. 

Она является простой двухпараметрической моделью турбулентности, в 

которой решаются два уравнения переноса, определяющие турбулентную 

скорость и время диссипации вихря. Стандартная k-epsilon модель, 

представленная во ANSYS Fluent, получила широкое применение в решении 

практических инженерных задач. Устойчивость и разумная точность для 

широкого диапазона турбулентных потоков делает ее наиболее применимой 

в промышленных задачах. Постоянные коэффициенты для этой модели 

турбулентности получены опытным путем и поэтому она является 

полуэмпирической.  

При определении параметров турбулентности k и   используются два 

дифференциальных уравнения в частных производных. Уравнение переноса 

турбулентной кинетической энергии имеет вид: 
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Уравнение переноса скорости диссипации турбулентной кинетической 

энергии имеет вид: 

2
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      

 

 Для других параметров  настройки сохраняются по умолчанию. 

 Затем нажимается кнопка OK, для того чтобы закрыть окно Viscous Model. 

3. При решении данной задачи нужно обязательно учитывать теплообмен 

и теплопередачу. Для этого необходимо подключить к решению уравнение 

энергии с помощью команды: 

Define → Models → Energy... 

 

Рисунок 1.9 – Меню включения уравнения энергии (Energy) 

 

В появившемся окне нужно поставить галочку в строке Energy Equation  и 

нажать ОК  (рисунок 1.9). 

1.3. Задание параметров модели смешения и свойств рабочего тела 

1. На следующем этапе моделирования  задаются параметры смешивания 

химических веществ (рисунок 1.10). Для этого выполняются следующие 

действия:   Define → Models → Species... 
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Рисунок 1.10 – Меню компонентов (Species Model) 

 

 

а) В первую очередь необходимо выбрать опцию Species Transport в  

перечне моделей  Model. 

б) В списке реакций Reactions выбирается опция Volumetric. 

в) Выбирается Diffusion Energy Source в перечне опций Options. 

г) В свойствах смеси Mixture Properties выбирается n-octane-air в 

материалах смеси Mixture Material. 

д) Для того чтобы закрыть окно Species Model, следует нажать кнопку OK. 

При этом откроется информационное диалоговое окно Information с 

сообщением: «Available material properties or methods have changed. Please 

conform the property values before continuing» («Исходные свойства 

материалов или процессы были изменены. Пожалуйста, убедитесь в том, что 

все значения характеристик согласованы»).  После выбора движения среды 

необходимо назначить состав смеси.  

е) Нажатием кнопки  OK закрывается информационное диалоговое окно 

Information. 
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2. Так как топливо, используемое в двигателе, является жидким то 

необходимо настроить параметры  процесса испарения топлива  

(рисунок 1.11). 

Define → Models → Discrete Phase... 

а) В первую очередь определяется  влияние границ раздела фаз: 

 Выбирается опция Interaction with Continuous Phase в списке 

Interaction. 

 В данном случае граница разделения фаз будет использоваться по 

умолчанию. 

 Затем выбирается опция Update DPM Sources Every Flow Iteration в 

списке настроек Interaction. 

б)   На следующем этапе открывается раздел физических моделей Physical 

Models. 

 Устанавливается настройка учета соударения капель Droplet Collision и 

дробления капель Droplet Breakup в разделе модели распыления Spray Model. 

 

Рисунок 1.11 – Меню настройки параметров  испарения (Discrete Phase Model) 
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1.4. Настройка граничных условий 

Меню задания граничных условий (рисунок 1.12) вызывается командой: 

Define → Boundary Conditions... 

 

Рисунок 1.12 – Меню настройки граничных условий (Boundary Conditions) 

 

1. В поле Zone находится список всех граничных условий, определенных 

в ANSYS Gambit. Если выбрать имя одного из них, например pressure_inlet.1, 

то в окне Type будет указан тип граничного условия. В случае необходимости 

в этом окне тип граничных условий можно поменять.  

а) Чтобы приступить к заданию граничных условий, необходимо в окне 

Zone выбрать нужное граничное условие pressure_inlet1, убедиться, что в 

окне Type тип граничного условия указан верно. 

б) Затем следует нажать клавишу  Edit: 
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Рисунок 1.13 – Меню настройки давления на входе (pressure_inlet) 

 

Значения избыточного давления на входе в строках Gauge Total Pressure 

и Supersonic/Initial Gauge Pressure равно нормальному атмосферному 

давлению 101325Па. Так как абсолютное давление на входе равно 

атмосферному, то избыточное давление в данной области равно 0. 

 В выпадающем списке Specification Method выбирается опция Intensity 

and Hydraulic Diameter. 

 В строке интенсивности турбулентности Turbulence Intensity вводится  

значение 10%. 

 В строке гидравлического диаметра Hydraulic Diameter введите 

значение 0,0096м. Гидравлический диаметр рассчитывается по формуле: 

dэ=4F/P, где F=π(Dкан
2
-Dкл

2
)/4 – площадь кольцевого сечения канала, 

P=π(Dкан-Dкл) – периметр кольцевого сечения канала, Dкан  – диаметр 

впускного канала,  Dкл -  диаметр стержня впускного клапана. 

 Затем выбирается вкладка Thermal (рисунок 1.14). 

 В строке Total Temperature вводится значение 297 К. 
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Рисунок 1.14 – Меню настройки температуры на входе (pressure_inlet) 

 

 Нажмите ОК и закройте окно параметров входного давления Pressure 

Inlet. 

2. Для задания параметров границы для подачи топлива в впускную область 

двигателя необходимо в окне Zone выбрать нужное граничное условие 

pressure_inlet2, убедиться, что в окне Type тип граничного условия указан 

верно (рисунок 1.15). 

а) Затем следует нажать клавишу  Edit: 

 

Рисунок 1.15 – Меню настройки давления на входе (pressure_inlet2) 
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Значения избыточного давления на входе в строках Gauge Total Pressure 

и Supersonic/Initial Gauge Pressure равно нормальному атмосферному 

давлению 101325Па. 

 В выпадающем списке Specification Method выбирается опция Intensity 

and Hydraulic Diameter. 

 В строке интенсивности турбулентности Turbulence Intensity вводится  

значение 10%. 

В строке гидравлического диаметра Hydraulic Diameter введите значение 

0,0017м. 

 Затем выбирается вкладка Thermal (рисунок 1.16). 

 В строке Total Temperature вводится значение 297 К. 

 

Рисунок 1.16 – Меню настройки температуры на входе (pressure_inlet2) 

 

 Нажмите ОК и закройте окно параметров входного давления Pressure 

Inlet. 
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3. Для задания граничного условия на выходной границе в меню Boundary 

Condition нужно выбрать имя данной границы (pressure_outlet) и нажать 

кнопку Set. Это вызовет появление меню Pressure Outlet (рисунок 1.17). 

 

Рисунок 1.17 – Меню настройки давления на выходе pressure_outlet 

 

а) Затем выбирается опция  Intensity and Hydraulic Diameter в 

выпадающем списке Specification Method. 

б) В строке интенсивности турбулентности Back flow turbulence Intensity 

выбирается  значение 10%. 

в) В строке гидравлического диаметра Back flow Hydraulic Diameter 

указывается значение 0,0116м. Гидравлический диаметр рассчитывается 

аналогично подобному расчету для впускного клапана (давление на входе). 

г) Затем следует выбрать вкладку Thermal. 

д) Затем в строке Back flow Total Temperature вводится значение  

температуры 297К (рисунок 1.18). 
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Рисунок 1.18 – Меню настройки температуры на выходе pressure_outlet 

 

е) Для подтверждения всех введенных параметров необходимо нажать 

кнопку ОК и закройте окно параметров выходного давления Pressure Outlet. 

 

1.5. Настройка зон пересечения сетки 

Данная настройка необходима для получения движущейся сетки и на 

этом этапе следует настроить проницаемость границ между расчетными 

зонами (рисунок 1.19). 

Define → Mesh Interfaces → Create/Edit... 
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Рисунок 1.19  – Меню задания проницаемости между зонами (Create/Edit Mesh Interfaces) 

 

Для этого в данном меню следует выполнить следующую 

последовательность действий: 

1. В списке Interface Zone 1 выбирается строка interface_cyl_ks. 

2. В списке Interface Zone 2 выбирается строка interface_ks_cyl. 

3. В строке Mesh Interface вводится имя int_cyl-ks. 

4. Затем следует нажать клавишу Create. 

5. Аналогичным образом задается проницаемость между зонами, 

указанными в таблице: 

Interface Zone 1 Interface Zone 2 Mesh Interface 

interface_cyl_vp-vip interface_vip_cyl 

interface_vp_cyl 

int_cyl-vp_vip 

interface_kar1_kv1 interface_kv1_kar1-kv 

interface_kv1_kar1-kv-

prot 

int_kar1-kv1 

interface_kar2_kv2 interface_kv2_kar2 int_kar2-kv2 

interface_kart-bok_plosk interface_plosk_kart-bok int_kart_bok-plosk 

interface_kart-niz_plosk interface_plosk_kart-niz int_kart_niz-plosk 

interface_kv_vh interface_vh_kv  int_kv-vh 

interface_plosk_pod_porsh interface_pod-porsh_plosk int_plosk-pod_porsh 
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6. Закройте окно Create/Edit Mesh Interfaces. 

 

1.6. Настройка параметров движения сетки 

1. Задание динамической модели движения сетки и её основных 

параметров (Рисунки 1.20-1.21) осуществляется следующим образом: 

Define → Dynamic Mesh... 

При этом выполняется следующая последовательность действий: 

а) Устанавливается галочка перед Dynamic Mesh. 

б) Выбирается тип перестройки параметров сетки во время ее движения. 

Для этого устанавливаются галочка перед  Layering. 

в) Активизируется опция In-Cylinder. 

Задание опции In-Cylinder позволяет использовать учет 

дополнительных условий движения поршня. 

 

 

Рисунок 1.20  – Меню динамической сетки (Dynamic Mesh) 

 

г) После этого следует нажать опцию Settings… в разделе Mesh Methods. 
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д) В данной опции указываются следующие параметры для схемы 

движения сетки Layering (рисунок 1.21): 

 

Рисунок 1.21  – Меню параметров для схемы движения сетки Layering 

 

е) Для подтверждения всех введенных параметров следует нажать кнопку 

ОК. 

ж) Активизируется опция  Settings… в разделе in-Cylinder. В ней задаются  

параметры, указанные на рисунке 1.22 (или параметры моделируемого Вами 

цилиндра). Модель In-Cylinder обычно используется при моделировании 

процессов в ДВС. Это облегчает задачи моделирования движения поршня. 

Здесь Crank Shaft Speed – частота вращения коленчатого вала (об/мин.), 

Starting Crank Angle – начальный угол поворота коленчатого вала, Crank  

Period – время цикла в градусах (для двухтактного двигателя 360º), Crank 

Angle Step Size– угол поворота коленчатого вала за один шаг, Piston Stroke– 

ход поршня в метрах, Connecting Rod Length – длина шатуна в метрах. 

з) После установки всех параметров движения поршня в двигателе 

следует нажать кнопку  ОК. 

 



 
 

25 

 

Рисунок 1.22  – Меню параметров настройки движения поршня (In-Cylinder Settings) 

 

2. Следующим этапом моделирования является загрузка файла для 

компилирования UDF функции вращения коленчатого вала (рисунок 1.23): 

Define → User-Defined → Compiled... 

 

 

Рисунок 1.23  – Путь выбора меню компиляции 
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Появится окно Compiled UDFs (рисунок 1.24) в котором необходимо нажать 

на клавишу Add… под полем Source Files. 

 

Рисунок 1.24  – Окно выбора файла для компилирования  

 

После нажатия кнопки Add и выбирается файл  DVS.c (рисунок 1.25). 

 

Рисунок 1.25  – Окно выбора файла с законом движения области сетки 
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Далее нажимается кнопка Build. При этом появится предупреждение о том 

что файлы DVS.c и case Вашего проекта должны находится в одной рабочей 

директории. Нажимается кнопка OK. В результате чего в окне командной 

строки будет отображен процесс компиляции функции записанной в файле 

DVS.c, загрузки и создания необходимых библиотек для работы компилятора 

MS Visio C++. После корректного процесса компиляции, в командной строка 

будет содержать записи как на рисунке 1.26. 

 

Рисунок 1.26  – Содержимой командной строки после выполнения процесса компиляции 

 

3. После этого вводятся параметры  движения поршня и других 

подвижных элементов моделируемого двигателя. Для этого выполняется 

следующая последовательность действий: 

Define → Dynamic Mesh... 

а) Активизируется опция Create/Edit… нажатием соответствующей 

кнопки под окном Dynamic Mesh Zones. 

б) Осуществляется задание параметров области porsh (рисунки 1.27-1.28): 
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 Сначала выбирается область  porsh в выпадающем списке Zone Names. 

 Выбирается опция  Rigid Body в списке Type. 

 Затем следует выполнить настройки в  разделе опции движения данной 

области сетки Motion Attributes: 

- Выбирается **piston-full** в выпадающем списке  Motion UDF/Profile. 

- Вводятся следующие значения в разделе Valve/Piston Axis: 

X 0 

Y 1 

Z 0 

X=cosα и Y=sinα, где α – угол между осью цилиндра и осью абсцисс, в нашем 

случае ось цилиндра перпендикулярна оси абсцисс, следовательно, 0X , 

1Y , 0Z   

 В опции Meshing Options необходимо ввести значение 0,0005 м в 

разделе Cell Height. 

 Для подтверждения всех введенных параметров следует нажать 

клавишу Create. 

 

Рисунок 1.27  – Меню задания Motion Attributes параметров зоны сетки porsh  
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Рисунок 1.28  – Меню задания Meshing Options параметров зоны сетки porsh  

 

Аналогичным образом задаются параметры остальных зон, в 

соответствии с нижеприведенной таблицей. 

 

Zone 

Names Type 

Motion Attributes 
Meshing op- 

tions (m) 
Motion 

UDF/Profile 

Valve/Piston Axis 

X Y Z 

interface_kv

1_kar1_kv 

Rigid Body kv::libudf    0,0005 

interface_kv

1_kar1-kv-

prot 

Rigid Body kv::libudf    0,0005 

interface_kv

2_kar2 

Rigid Body kv::libudf    0,0005 

interface_kv

_vh 

Rigid Body kv::libudf    0,0005 

interface_pl

osk_pod-

porsh 

Rigid Body **piston-

full** 

0 1 0 0,0005 

interior_kv Rigid Body dvs::libudf    0,0005 
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0 

interior_kv-

prot 

Rigid Body dvs::libudf    0,0005 

0 

interior-

polost-porsh 

Rigid Body **piston-

full** 

0 1 0 0,0005 

0 

polost-porsh Rigid Body **piston-

full** 

0 1 0 - 

wall-kv Rigid Body dvs::libudf    0,0005 

wall-kv-prot Rigid Body dvs::libudf    0,0005 

X=cosα и Y=sinα, где α – угол между осью клапана и осью абсцисс. 

 

4. После всех выполненных операций необходимо закрыть окно Dynamic 

Mesh Zones (рисунок 1.29). 

 

Рисунок 1.29 – Меню задания подвижных зон 

 

5. Выполненные прежде настройки позволяют установить время, в 

которое будут происходить то или иное динамическое событие, имеющее 

место в цилиндре ДВС, такое как открытие и закрытие выпускного окна. Это 

осуществляется следующим образом (рисунок 1.30): 

Define → Dynamic Mesh → Events... 
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Рисунок 1.30 – Меню задания динамических событий (Events) 

 

а) Вводится количество событий Number of Events. В данном случае оно 

равно 2. 

б) В первой строке списка названий событий (Name)вводится – in. 

в) Затем следует отметить галочкой поле ON напротив события in. 

г) В разделе At Crank Angle вводится для in значение равное 90 (градус 

поворота коленчатого вала ДВС). 

д) После этого следует нажать клавишу Define для открытия окна Define 

Event (рисунок 1.31). 
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Рисунок 1.31 – Меню определения событий (Define Event) 

 

В данном окне производятся следующая последовательность действий: 

 Выбирается опция  Create Sliding Interface в выплывающем списке 

Type. 

 Вводится in в строке указания  имени пересечений зон сеток  Interface 

Name в разделе Definition.  

 Выбирается interface_vip_cyl и interface_vp_cyl в Interface Zone 1. 

 Выбирается interface_cyl_vp-vip в Interface Zone 2. 

 Настройки, заданные по умолчанию в строках Wall 1 Motion и Wall 2 

Motion остаются неизменными. 

 Затем нажимается кнопку OK. При этом закроется окно Define Event. 

 Далее задается закрытие «зоны» ex следующими командами Dynamic 

Events. Для этого следует нажать клавишу Define для открытия окна Define 

Event: 
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 Выбирается опция  Delete Sliding Interface в выплывающем списке 

Type. 

 Вводится in в строке указания  имени пересечений зон сеток  Interface 

Name в разделе Definition.  

 Затем нажимается кнопку OK. При этом закроется окно Define Event 

(рисунок 1.32). 

 

Рисунок 1.32 – Меню определения событий (Define Event) 

 

е) Для того чтобы сохранить произведенные настройки следует нажать 

клавишу Apply. 

ж) После этого следует закрыть окно Dynamic Mesh Events. 

 

1.7. Настройка параметров процесса впрыска 

Настройка параметров и  характеристик процесса впрыска топлива 

выполняется следующим образом: 

Define → Injections... 

1. В окне Injections выбирается команда создать (Create). При этом 

открывается  окно свойств процесса впрыска топлива Set Injection Properties 

(рисунок 1.33). 
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Рисунок 1.33 – Меню свойств впрыска топлива (Set Injection Properties) 

 

В нем выполняется следующая последовательность действий: 

а) В строке типа впрыска  топлива Injection Type выбирается surface. 

б) В списке Particle Type следует выбрать капельный распыл Droplet. 

в) В строке Material следует выбрать n-octane-liquid. 

г) В строке распределения диаметров капель Diameter Distribution следует 

выбрать  uniform. 

д) Для процесса впрыска необходимо открыть вкладку точечные свойства 

Point Properties и для каждого из свойств установить  следующие 

характеристики: 

Parameter Value 

X- Velocity (m/s)  0  

Y- Velocity (m/s)  -5  

Z-Velocity (m/s)  0  

Diameter (m)  0 .001 

Temperature (k )  300 

Start Crank Angle (deg) 150 

Stop Crank Angle (deg) 380 

Total Flow Rate (kg/s) 0 .0003 
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В данном случае X-Velocity(м/с), Y-Velocity(м/с), Z-Velocity(м/с) – 

составляющие скорости струи топлива, разложенной по осям координат, 

Temperature (K) – температура топлива, Start Crank Angle (deg) и Stop Crank 

Angle (deg) – углы начала и конца  процесса впрыска топлива, Total Flow Rate 

(кг/с) – массовый расход топлива, Diameter(м) – диаметр капли. 

з) Затем следует выбрать вкладку турбулентной дисперсии Turbulent 

Dispersion. В нижней половине окна откроется строка модели турбулентной 

дисперсии. Эти модели будут рассчитываться для турбулентной дисперсии 

капель. 

 Выбирается строка Discrete Random Walk Model. 

 Оставляется неизменным значение в строке Time Scale Constant. 

 Для подтверждения всех введенных параметров настройки процесса 

впрыска следует нажать ОК и закрыть  окно параметров впрыска Set Injection 

Parameters. 

и) После этого следует закрыть  окно настройки параметров впрыска 

Injections. 

 

1.8. Предварительный просмотр движения сетки 

1. Для выполнения дальнейших действий необходимо сохранить файл 

проекта (miniDVS.cas). 

File → Write → Case... 

При этом следует убедиться, что сохранены все изменения до вывода 

сетки на экран. 

2. Затем необходимо вывести сетку на экран с помощью следующих 

действий: 

Display → Mesh... 

а) Выбираются все поверхности из списка Surfaces. 

б) Затем нажимается клавиша Display. 

в) После этого следует закрыть окно Mesh Display. 
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3. Для настройки  параметров предварительного просмотра сетки 

(рисунок 1.34) выполняется следующие действия: 

Define → Dynamic Mesh → Preview Mesh Motion... 

 

Рисунок 1.34 – Меню предварительного просмотра движения сетки (Mesh Motion) 

 

а) В строке Number of Time Steps следует ввести число 180. Данное 

значение обеспечит полный поворот коленчатого вала. 

После этого выполняется предварительный просмотр движения сетки. 

Для этого нажимается  кнопка Preview. Во время, когда происходит 

обновление сетки программой ANSYS Fluent, в дополнительном окне 

появляется сообщение, показывающее процесс его выполнения. 

в) После этого следует закрыть окно Mesh Motion. 

 

1.9. Настройка начальных параметров модели 

1. Для выполнения данной настройки процесса моделирования следует 

открыть файл miniDVS.cas 

File → Read → Case... 

При этом откроется информационное диалоговое окно: «Имеющиеся 

характеристики материалов и методы должны быть сохранены. Чтобы 

продолжить убедитесь в правильности имеющихся значений» (Available 

material properties or methods have changed. Please confirm the property values 

before continuing).  

Необходимо нажать кнопку ОК, для того чтобы закрыть это окно. 
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2. Затем следует установить параметры начальных условий для области 

потока с помощью процесса инициализации процесса решения 

(рисунок 1.35): 

Solve → Initialization... 

 

Рисунок 1.35 – Меню инициализации решателя 

 

При этом выполняются следующие действия: 

а) В строке Gauge Pressure вводится  значение «101325». 

б) В строке X Velosity вводится  значение «0». 

в) В строке Y Velosity вводится  значение «0». 

г) В строке Turbulent Kinetic Energy вводится значение «0,01». 

д) В строке Turbulent Dissipation Rate вводится значение «0,01». 

е) В строке c8h18 вводится значение «0». 

ж) В строке Temperature вводится значение «297». 

з) Затем следует нажать клавишу Initialize. 

 

1.10. Настройка процесса создания анимации 
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1. После этого следует произвести настройку процесса создания 

анимации. Данный процесс осуществляется следующим образом 

(рисунок 1.36):   Solve → Calculation Activities... 

а) Сначала следует нажать кнопку  Create/Edit... в окне  Solution 

Animations. 

б) В данном окне в опцию Animation Sequences следует  ввести количество  

анимации, которое будет создано в процессе решения. В данном случае оно 

будет равно  числу 5. 

 

Рисунок 1.36 – Меню задания анимации (Solution Animations) 

 

в) В первой строчке вводится имя Velocity. 

 Во вкладке When устанавливается параметр  Time Step. 

 Затем нажимается кнопка  Define... 

 В появившемся окне (рисунок 1.37) необходимо ввести 2 в число окон 

(Window) и нажать клавишу Set. 

 В опции типа отображений расчетных данных Display Type следует 

выбрать их векторную форму Vectors. Затем следует нажать для 

последующей настройки клавишу Edit. 
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Рисунок 1.37 – Меню параметров анимации (Animation Sequences) 

 

 В появившемся окне (рисунок 1.38) необходимо установить  5 в  

опциях качества отражения векторов Scale и  в Skip. 

 

Рисунок 1.38 – Меню настройки векторов скорости(Vectors) 

 

 Затем следует нажать кнопку  Display и закрыть окно настройки, нажав 

для этого клавишу Close. 

 После этого следует нажать клавишу OK в окне Animation Sequence. 
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г) Затем во второй строчке в окне  Solution Animations вводится имя 

следующей анимации Pressure. 

 Во вкладке When устанавливается тип записи Time Step. 

 После этого следует нажать кнопку Define... 

 В появившемся окне ввести число 3 в опцию Window. В окно №3  будет 

происходить запись анимации изменения давления в цилиндре ДВС. После 

выполнения данного действия следует нажать кнопку Set. 

 В опции вида отображения расчетных данных Display Type следует 

выбрать  Contours (рисунок 1.39). После этого следует нажать для 

последующей настройки клавишу Edit. 

 

Рисунок 1.39 – Меню параметров анимации 

 

 В появившемся окне (рисунок 1.40) во вкладке Contours of следует 

выбрать Pressure… и  Absolute Pressure. 
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Рисунок 1.40 – Меню настройки полей распределения давления 

 

 Затем следует нажать  кнопку Display и закрыть  данное окно, нажав 

кнопку Close. 

 Для подтверждения всех введенных значений и настроек  следует 

нажать кнопку  OK в окне Animation Sequence. 

д) Затем вводится в окне  Solution Animations в третьей строчке имя 

следующей анимации  - Temperature. 

 Во вкладке When следует установить Time Step. 

 Затем нажимается кнопка  Define... 

 В появившемся окне ввести число 4 в опцию Window. В окно №4  будет 

происходить запись анимации изменения температуры в цилиндре ДВС. 

Затем нажимается  кнопка Set.. 

 В опции вида отображения расчетных данных Display Type следует 

выбрать  Contours . После этого для последующей настройки следует нажать 

клавишу Edit. 

 В появившемся окне во вкладке Contours of выбирается соответственно 

Temperature… и Total Temperature. 
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 После этого следует нажать Display и закрыть окно, нажав кнопку  

Close. 

 Для подтверждения всех введенных значений и настроек  нажимается 

кнопка  OK в окне Animation Sequence. 

е) В четвертой строчке в окне  Solution Animations вводится имя c8h18. 

 Во вкладке When устанавливается Time Step. 

 Затем нажимается кнопка Define... 

 В появившемся окне вводится число 5 в опцию Window и нажимается 

кнопка настройки Set. 

 В опции Display Type выбирается  Contours. 

 В появившемся окне во вкладке Contours of  выбирается 

соответственно Species… и Mass fraction of  c8h18. 

 Затем следует нажать кнопку Display и закрыть  окно с помощью 

нажатия кнопки  Close. 

 После этого нажимается кнопка OK в окне Animation Sequence. 

ж) В окне  Solution Animations (рисунок 1.41) в пятой строчке вводится 

имя mesh. 

 Во вкладке When устанавливается Time Step. 

 

Рисунок 1.41 – Меню задания анимации 
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 После этого нажимается кнопка Define... 

 В появившемся окне (рисунок 1.42) вводится число 6 в опцию Window 

и нажимается кнопка настройки Set. 

 В открывшемся окне в опции Display Type выбирается Mesh. 

 

Рисунок 1.42 – Меню параметров записи анимации движущейся сетки 

 

 В появившемся окне во вкладке Mesh Display выделяются  все 

поверхности surfaces (рисунок 1.43). 

 

Рисунок 1.43 – Меню настройки отображения сетки 

 

 После этого следует нажать кнопку Display и закрыть окно, нажав 

кнопку Close. 
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 Затем для подтверждения всех введенных параметров необходимо 

нажать кнопку OK в окне Animation Sequence. 

з) Для завершения настроек процесса записи анимации необходимо 

закрыть окно Solution Animation, нажав клавишу OK. Аналогично можно 

настроить запись анимации  полей распределений и векторов других 

параметров. 

2. Сохранение файла (miniDVS.cas) текущего проекта осуществляется за 

счет вызова следующей команды: 

File → Write → Case&Data... 

После ее вызова следует нажать кнопку ОК для перезаписи первичного 

файла. 

 

1.11. Запуск решения задачи 

1. Для запуска решения задачи следует выбрать следующую команду: 

Solve → Run Calculation... 

 

Рисунок 1.44 – Меню запуска выполнения решения(Run Calculation) 
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В меню Run Calculation (рисунок 1.44) выполняются следующие 

действия: 

а) В строке Number of Time Steps выбирается количество шагов расчета, 

равное 180. 

б) В строку Max Iterations per Time Step вводится максимальное 

количество итераций на один шаг расчета. В данном случае рекомендуется 

ввести число 200 для данного параметра. 

в) После этого нажатием клавиши Calculate запускается расчета 

процессов внутри ДВС. 

 

1.12. Сохранение анимации 

 Данная процедура выполняется в следующей последовательности: 

Display → Graphics and Animations... 

а) В окне Animations выбирается опция Solution Animation Playback и 

нажимается  Set Up... 

б) В появившемся окне (рисунок 1.45) выбирается какой-либо 

термодинамический параметр, который предварительно описан в пункте 1.9, 

например Velocity. 

в) В опции Write/Record Format выбирается тип файла MPEG. 

 

Рисунок 1.45 – Меню работы с анимацией 
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г) Для того чтобы запустить процесс сохранения  следует нажать кнопку 

Write. 

д) Затем следует закрыть данное  окно,  нажав кнопку Close. 

1.13. Просмотр результатов расчета 

Для просмотра результатов расчета необходимо воспроизвести 

видеопроигрывателем сохраненные анимации соответствующих 

термодинамических параметров (рисунки 1.46 -1.48) 

 

Рисунок 1.46 – Поле распределения температур 

 

Рисунок 1.47 – Поле распределения давлений. 
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Рисунок 1.48 – Поле распределений векторов скоростей. 
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ЗАКЛЮЧЕНИЕ 

По результатам выполненной работы можно сделать следующие выводы: 

1. Применение CAD/CAE – технологий для моделирования процессов в 

внутри ДВС позволяет снизить сроки проектирования ДВС за счет ускорения 

процесса расчета. 

2. Высокая информативность результатов численного моделирования 

способствует более детально анализировать рабочий процесс ДВС. 

3. Моделирование газодинамической структуры потока при 

обоснованном выборе модели турбулентности позволяет с достаточной для 

практики точностью получить распределения основных термодинамических 

параметров внутри цилиндра двигателя. 

4. Использование программы ANSYS Fluent позволяет проводить 

моделирование процесса впрыска топлива с учетом не стационарности  

данного процесса и движения отдельных узлов цилиндропоршневой группы. 
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